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Scrum

Es una metodologia agil y flexible que se
utiliza para gestionar proyectos, su
principal objetivo es apoyar proyectos
donde el entorno de estos es muy
cambiante en cuanto a tecnologias,
requerimientos y equipos, maximizando
el retorno de la inversién (ROI) al cliente.
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http://www.youtube.com/watch?v=XDOayQIuC78
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Scrum

Utilizando Scrum:

SPRINT O

Se mejora la calidad del producto final.

e Se mejora la productividad de los integrantes.

e Se realiza un seguimiento diario de los avances del
proyecto
Se realizan iteraciones cortas.

® Se realizan sprints, con entregables semi-cerrados
que sirven para que el cliente pueda obtener los
beneficios del proyecto en forma incremental.

® Los entregables deben ser presentados como un
resultado finalizado, lo que se conoce como
incremento de producto.

Esto le permite ver al cliente el progreso y resultado del
proyecto en varias etapas dentro del mismo proyecto.
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El proceso de Scrum

Se trabaja con iteraciones cortas
(Sprints), donde cada iteracion
(normalmente de 2 semanas) debe
representar un incremento de producto

gue pueda ser presentado al cliente
como un resultado finalizado.
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El producto a desarrollar

Las caracteristicas a desarrollar durante
cada iteracion salen del Product
Backlog: Nombre con el que se conoce
al conjunto de requisitos priorizados.

ol

! o s— e, )
‘ o = Estas caracteristicas se determinan al
' S — inicio de cada sprint, en la reunion que

.

— se conoce como Sprint Planning.
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Sprint Planning

En esta reunidn el Product Owner en conjuntc
con el equipo (SCRUM Team) determinan que

elementos del Product Backlog se pueden

comprometer a desarrollar y se clarifican las
historias seleccionadas.

Esta nueva lista de tareas a realizar se conoce
como Sprint Backlog. Una vez comenzado el

sprint, tanto las historias que conforman el
Sprint Backlog como los requerimientos de las
mismas no pueden ser modificados.
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Ejecucion del sprint en Scrum

Se realizan reuniones diarias (Daily Scrum) durante el sprint con
el fin de mantener la comunicacién y la productividad del
equipo, normalmente frente a un tablero y con el uso de POST
ITS.

En estas reuniones cada integrante participa respondiendo a 3
preguntas:

¢En que trabajo el dltimo dia?

¢éEn que va a trabajar hoy?

éHay alguna tarea que se vea bloqueada por algun
motivo?

Es el Scrum Master el que debe asegurar que el equipo pueda
cumplir con su trabajo.
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Ejecucion del sprint en Scrum

Una vez finalizado el sprint se realizan 2 reuniones mas:

Sprint Review Sprint Retrospective
Aqui analiza el trabajo realizado, que items Aqui los integrantes del equipo dan su
fueron terminados y cuales no y se presenta opinion sobre el sprint finalizado y se

al cliente el trabajo finalizado. proponen mejoras sobre el proceso.
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Interesados en el proyecto,

producto o necesidad Scrum Master - e
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Product Owner Scrum Team

Sprint Review
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En el review se revisa la
entrega o el producto

Sprint Planning incremental
Meeting

4 Sprint BackLog
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2. Git y Github
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Git - Funcionamiento basico

éPor qué un Sistema de Control de Estructura de Git
Versiones? o —

e No trabajamos solos.

e Si modificamos un proyecto i
directamente, no tenemos | ! |
constancia de como era antes de S E—
los cambios.

e Seguridad. s |

Version 2 Version 2

Version 1 Version 1

‘Mision
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Los tres estados de Git

Staging .git directory
Area (Repository)

Working
Directory

Checkout the project

e
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Working Directory: Traemos una copia
de los ficheros del repositorio: checkout
(sobreescribimos) o pull (merge).

Staging Area: Preparas los archivos,
anadiendolos a tu area de preparacion :
add.

.git directory: Confirmar los cambios tal
y como estan en el area de preparacion
y guarda un snapshot : commit
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Trabajo en equipo

e (Cada equipo tendra un repositorio Github
® Trabajar en el repositorio ¢COMO TRABAJAR EN EQUIPO CON GIT?

e (No p!

el pro

@ RAMA MASTER

a. Inicializar el repositorio local: git init
Traer el directorio remoto: git clone <repositorio>
Crear rama para la funcionalidad a trabajar: git checkout -b <funcionalidad>
Anadir los cambios necesarios a la rama.
Anadir los cambios al stage: git add .
Registrar los cambios: git commit -m “<mensaje>"
Subir cambios al repositorio remoto: git push -u origin <funcionalidad>
Crear un Pull Request (PR)
m Hacer revision del codigo

S@m 0 oo0 o

m Realizar mezcla del PR
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Trabajando con ramas en Git °

o |

|

® C(Crear unarama: ® \er los cambios entre ramas ‘ |

$ git checkout -b ramal $ git diff --stat master ramal .,

® \er en gque rama estamos ® Fusionar ramas ©

$ git branch $ git checkout master O '

$ git merge --no-ff ramal O ‘

e Cambiar de rama | |
e Eliminar la rama @)

$ git checkout master ‘ ‘

$ git branch -d ramal Q |
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@ RAMA MASTER (No puedes trabajar aqui): Es donde esta

el proyecto principal, nunca debes tocarla.
©O—

@ RAMA DEV f v \i/ @ 1. Cada desarrollador

1
v
(Aqui es donde puedes ”@” v 9 puedesdcar su propia

————————— —

trabajar): Saca las ramas '.i_? [ .Tﬁ rama de la “rama dev”
que quieras y trabaja sin : : ; y trabajar en lo que le
preocupaciones. | W corresponde.
—/—\:::/— —_— —\:'L — —\1/— ————————————— —
@ 2. Luego estas (
ramas se vuelven 1
a unir a través de /,--- L) Y Masteresta
Merge. e | w9+ actualizado con
w | - todos los cambios
—feain =i A ks hechos por los
v e \
n N, programadoresy la
@® @ @3. Se integran app funcionando.
3. Si hay conflictos se deben los cambios a la
corregir (Lider de proyecto o rama Master.

integracion continua).

Aprende cémo usan Git los equipos de desarrollo de software en:
. ‘ )EDteam
>- ed.team/cursos/git-workflow




MINISTERIO DE TECNOLOGIAS

DE LA INFORMACION Y LAS ST ‘Mision
COMUNICACIONES gz TIC2022

Pull request

2

tifi
Crear larama notific
i i 1 t
Subir los cambios en local 1 genera P redues
Subir los cambios . - oo

Ir a github y solicitar una

pull request

e Anadir los comentarios:
(también se pueden anadir
revisores)

® Los revisores de coédigo feature_xxx

tienen tres opciones:
O ahadir comentarios
O aceptar los cambios

o rechazarlos develop “

A R YN

modifica
cambios

Review

—
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¢ Qué es Flutter?

Futer a5 un conjunto e herramienas [

de Google para construir experiencias .%
)

nativas de alta calidad para movil, web y < @ 2
escritorio en tiempo récord. C QUE E S

% Flutter % Flutter



http://www.youtube.com/watch?v=sqkmEp7q7L8
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fernando-herrera.com

Instalaciones en
Windows

’ fernando_her85

MacOS y Windows: https://www.youtube.com/playlist?list=PLCKuOXG0bPi3xBRYOmcfogrchgRJOafo9


https://www.youtube.com/playlist?list=PLCKuOXG0bPi3xBRYOmcfoqrchgRJOafo9
http://www.youtube.com/watch?v=3N8MMvLBxss
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Requerimientos Minimos recomendados

Windows Linux
e Sistema Operativo: Windows 10 o superior e Sistema Operativo: Linux (64-bit)
e Disco: 1.64 GB disponibles e Disco: 600 MB disponibles
® Herramientas: e Herramientas:
o  Windows PowerShell 5 o superior ® bash
o  Git for Windows 2.x ® —~gurk
° file
° git 2.x
macOS ° mkdir
[ ] rm
e Sistema Operativo: macOS e unzip
e Disco: 2.8 GB disponibles e which
. o xz.utils
e Herramientas: . A
p

o git2.x
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Instalar Flutter (https://docs.flutter.dev/get-started/install)

1. Descarga el siguiente paquete de instalacion 3. Actualizar el path
para obtener la version mas reciente stable a. Desde la barra de busqueda en Inicio, escribe ‘env’ y
release del SDK Flutter: selecciona Editar variables de entorno para tu
(flutter windows 3.3.3-stable.zip)

2. Extraiga el archivo zip y coloque el contenido

cuenta
b. Debajo de Variables de usuario verifica si existe una
entrada llamada Path:

de flutter en la ubicacion deseada de i.  Silaentrada existe, agrega la ruta completa a
instalacién para el Flutter SDK (ej. flutter\bin usando ; como separador de los
C:\src\flutter; no instale flutter en un valores existentes.

ii. Silaentrada no existe, crea una nueva

directorio como C:\Program Files\ que
variable de usuario llamada Path con la ruta

requiere permisos de administrador).
completa flutter\bin como su valor.



https://docs.flutter.dev/get-started/install
https://storage.googleapis.com/flutter_infra_release/releases/stable/windows/flutter_windows_3.3.3-stable.zip
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Instalar Flutter (https://docs.flutter.dev/get-started/install)

B Administrator: Command Prompt
Microsoft Windows [Version 10.0.17134.471]
(c) 2018 Microsoft Corporation. All rights reserved.

4. Ejecutar flutter doctor

C: \WINDOWS \system32>flutter doctor -v

5- |n5ta|ar AndrOId StUle Flutter version 1.0.0 at C:\src\flutter

Framework revision 5391447fae (3 weeks ago), 2018-11-29 19:41:26 -0800

H H o Engine revision 7375a0f414
a. Descarga e instala Android Studio. Dart version 2.1.6 (build 2.1.0-dev.9.4 f9¢6£21297)
b. Inicia Android Studio, y sigue todo el ‘Android Android toolchain - develop for Android devices (Android SDK 28.0.3)
4 Android SDK at C:\Users\HP\AppData\Local\Android\sdk
. . ’ s .7 Android NDK location not configured (optional; useful for native profiling support)
Studio Setup Wizard’. Este Instalara la versién Platforn android-28, build-tools 28.0.3
ANDROID_HOME = C:\Program Files\Android
A H 1 H Java binary at: C:\Program Files\Android\Android Studio\jre\bin\java
mas reCIente de AndrOId SDK’ AndrOId SDK Java version OpenJDK Runtime Environment (build 1.8.0_152-release-1024-b02)
. A All Android licenses accepted.
Platform-Tools y Android SDK Build-Tools, Las
Android Studio (version 3.2)
H Android Studio at C:\Pr Files\Android\Android Studi
cuales son requeridas por Flutter cuando se b b
. Dart plugin version 181.5656
desarrolla para Android. Java version OpenJDK Runtime Environment (build 1.8._152-release-1024-b02)

VS Code, 64-bit edition (version 1.30.0)

CO nfigu rar tu dispositivo Android VS Code at C:\Program Files\Microsoft VS Code

Flutter extension version 2.14.0

. Configurar el emulador de Android Connected device (1 available)

Mi Al « 324821030404 « android-arm64 e Android 8.1.0 (API 27)

6
7
8. Configurar Android Studio Mo S5 ol
9. Configurar Visual Studio Code (opcional)

10. Ejecutar flutter doctor -v



https://docs.flutter.dev/get-started/install
https://developer.android.com/studio
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Configurar tu dispositivo Android

Conecta tu dispositivo Android a tu
computadora con un cable USB. El tipo
de conexion correcta deberia aparecer
como connected as a media device
(conectado como un dispositivo de
medios).
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Abre el menu Settings  Pulsa en About phone Pulsa en el nimero de  Sigue pulsando hasta Regresa al menu principal En Android Studio navega
(Configuraciones) en (Acerca del teléfono) y compilacion varias que la ventana Settings > System > hasta el menu superiory
tu teléfono Androidy  despldzate hacia abajo veces. Pronto deberias  emergente diga que Advanced selecciona Run 'app' (Ejecutar
desplazate hasta la de nuevo hasta que ver una ventana eres un (Configuraciones > ‘aplicacién'). Android Studio
parte inferior. veas la opcidn Build emergente que dice desarrollador. Sistema > Avanzado). mostrard un cuadro de
number (Nimero de algo similar a You are Las opciones de didlogo en el que puedes
compilacién). five taps away from desarrollador deberian ser elegir en qué dispositivo
being a developer la pentltima opcidn. ejecutar tu aplicacidn
(Estds a cinco Activa las opciones de Android. Elige el dispositivo
pulsaciones de ser un desarrollador. que conectaste y haz clic en

desarrollador). el botén OK
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Configurar el emulador de Android

e Simula dispositivos Android en una
computadora para que puedas probar tu app
en diferentes dispositivos y niveles de API de

\ ' Android sin necesidad de contar con los
" dispositivos fisicos.
® Proporciona casi todas las funciones de un
dispositivo Android real.
e Puedes simular llamadas y mensajes de texto
' entrantes, especificar la ubicacién del

dispositivo, utilizar diferentes velocidades de

red, probar sensores de rotacién y otros

sensores de hardware, acceder a Google Play
Store y mucho mas.



http://www.youtube.com/watch?v=5rkmsYF8ASI
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Requisitos y recomendaciones

El uso de la aceleracion de hardware implica requisitos
adicionales en Windows y Linux:

e Procesador Intel en Windows o Linux: procesador Intel
compatible con Intel VT-x, Intel EM64T (Intel 64 Bit) y
funcionalidad Execute Disable (XD)

e Procesador AMD en Linux: procesador AMD compatible con
AMD Virtualization (AMD-V) y extensiones complementarias
de transmisidon SIMD 3 (SSSE3)

® Procesador AMD en Windows: Android Studio 3.2 o posterior,
y Windows 10 lanzado después de abril de 2018 para Windows
Hypervisor Platform (WHPX)

UT? Mision
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Imagen tomada de:https://www.freepik.es/



https://en.wikipedia.org/wiki/SSSE3
https://docs.microsoft.com/en-us/virtualization/api/
https://www.freepik.es/
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Dispositivos virtuales de Android (AVD)

[~ SV Ny VI

Android Virtual Device Manager

Your Virtual Devices
Android Studio

Name Play Store Resolution Target CPU/ABI Size on Disk Actions

10.1 WXGA (Tablet) ... 800 x 1280: mdpi Android 9.0 (Google APIs) x86 513 MB
Android TV (1080p) ... 1920 x 1080: xhdpi Android 9.0 (Android TV) x86 513 MB
Android Wear Round ... 320 x 320: hdpi Android 9.0 (Wear QS) x86 513 MB

Automotive (1024p la... 1024 x 768: mdpi Android 9.0 (Automotive) x86 513 MB

Pixel 3 API 28 1080 x 2160: 440dpi Android 9.0 (Google Play) x86 8.1 GB

+ Create Virtual Device...
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Configurar Android Studio

1. Inicie Android Studio.

Abra preferencias de complementos CI nd rOId
L
(Preferences>Plugins en macOS, StUd 10

File>Settings>Plugins en Windows & Linux).
3. Seleccione Browse repositories..., elige el

complemento de Flutter y presione install.
4. Presione ves cuando aparezca para instalar el
complemento de Dart.
5. Presione rRestart cuando aparezca.
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Configurar Visual Studio Code (opcional)

1. Inicie VS Code

Llame View>Command Palette...

3. Teclee install, y seleccione la accion Extensions:
Install Extension Visual Studio Code

4. Introduzca riutter en el campo de busqueda,
seleccione Flutter en la lista, y presione Install

5. Llame a View>Command Palette...

6. Teclee doctor, y seleccione la accion Flutter: Run
Flutter Doctor

7. Revise la salida en el panel OUTPUT para cualquier
inconveniente.

N




